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Harvest Time
FROM THE EDITOR
A few days ago, as I walked out my front door, I was surprised by an
unexpected change in temperature. The air was cooler, a welcome
relief after a summer of record high temperatures. The refreshing
change made me think about the onset of fall, the season when the
harvest begins for many farmers and the back-to-school harvest ends
for many dentists. Yet the most productive practices have learned to
extend the harvest, to reap in August, September, and throughout
the fall season.
To help your practice reap the best possible harvest this fall, this issue
of Dentrix Magazine includes several articles that provide suggestions
to maximize production and collection with Dentrix. In her article,
“Act Now to Boost Year-End Profits” (page 16), contributing editor
Erin Brisk explains how you can use Dentrix to identify and contact
patients who have treatment plans and remaining insurance benefits.
Practice administrator and consultant Jill Nesbitt shares proven
strategies to collect overdue accounts (page 24). And, because you
will almost certainly receive visits from new patients this fall, authors
Jim Philhower and May Wescott recommend customer service tactics
and Dentrix tips to create an exceptional new patient experience
(page 10).
I hope you enjoy reading these and other articles in Dentrix Magazine.
Please consult the reading guide on page 2 to find the articles that
correspond to your responsibilities in the dental practice. And
remember, every issue of Dentrix Magazine is available online at
www.dentrix.com/magazine. Download yours today.
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HOW TO LEARN MORE
If you want to learn more about the Dentrix topics featured in Dentrix Magazine, check out these self-paced learning resources.
Dentrix Help Files
In the Dentrix Help Files, you can explore a comprehensive
list of conveniently indexed topics or search the topics for key
words. To search the Help files, from the Help menu in any
Dentrix Module, click Contents, click the Search tab, type a
search phrase or topic name, click List Topics, and then under
Select Topic, double-click the topic name. Tip: To turn off the
search highlights, press F5.
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Dentrix Resource Center
The Dentrix Resource Center offers an online library
of on-demand software training videos, downloadable
product manuals, and a knowledgebase of technical support
articles. Access is free for dental practices on a Dentrix
Customer Service Plan. Log in today at www.dentrix.com/
resource-center.

Get Dentrix News, Tips
and Information
Sent Right to Your Inbox.
The Dentrix eNewsletter will help you stay up to
date on the latest Dentrix product information,
education opportunities, industry news, tips
and tricks, promotional offers and more!
Once a month you’ll receive an eNewsletter
featuring the following content:

P ro d u c t I n for mat i on
Training and Support
The Dental Business
Partner Products
T i p s an d Tr i cks

Sign Up Today at
www.dentrix.com/newsletter
and don’t miss out on the most up-to-date
Dentrix information!

www.Facebook.com/Dentrix
www.Twitter.com/Dentrix
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Dentrix News
New Insurance Carrier Connections

Dentrix now has an eClaims connection with several new
payors. If any of your patients are using these carriers, you
can reduce paper claims and submit claims through Dentrix
instead.

You can now reduce the need to duplicate X-rays, photos,
and other supporting claim documents by sending electronic
attachments to the following payors:

PAYOR ID

53287		 Blue Cross Blue Shield of Delaware

PAYOR NAME

PAYOR ID

PAYOR NAME

36659		 United Food & Comm Workers Unions
		 & Employers Midwest Health Benefits Funds

93200		 Regence BlueCross BlueShield of WA

37118		 Benefit Plan Administrators of VA

CB850		 Regence BlueCross BlueShield of OR

38194		 Group Health Managers (EHC Central)
75068		 Assurant Health Self-Funded
86066		 Hawaii Mainland Administrators

CBID2		 Regence BlueShield of Idaho
CX091		 MCNA Dental Plans

93842		Securian

DDPHS		 Delta Dental Public Health Services ADDP

CX111		 UFCW Local 655

TLU43		 Regence BCBS of Utah

HTD99		 Health Tradition—MMSI
IDIND		 Delta Dental of Illinois Individual Plan
LAHF1		 Local 17 Fund – International Assoc. of Heat
		 & Frost Insulators
TFQ67		 Samba Federal Employee Benefit Assoc.
TLU02		 Administration Systems Research Corporation
TLU02		 ASR Health Benefits
TLU02 		 Physicians Care

A benefit of Dentrix G5 is the ability to receive EOBs
electronically. The following payors are now connected to
provide this service.

PAYOR ID

PAYOR NAME

23281		 UPMC Health Plan

TLU02 		 Physicians Care Health Plus

38217		 Priority Health

TLU02 		 Physicians Care Network (MI)

59297		 Employers Mutual

TLX17 		 FirstCare Health/FirstCare
		 Administration Services

59332		WEB-TPA

TLX92		 ACMG of South Carolina
TPC05		 Sanford Health Plan of MN

71063		 HealthSCOPE Benefits
71412		 Mutual of Omaha Insurance Company
75261		 Community Health Electronic Claims
75261		CHEC
75261		WEB-TPA
CKKS1		 Medicaid of Kansas
View the entire list of electronic payor connections using
the Payor Search Tool at www.dentrix.com/products/eservices/
eclaims/payor-search.aspx. You can search for specific payors or
download the complete payor list.
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Join us for a half-day seminar on Dentrix
tips and tricks to help you and your practice
achieve new levels of productivity.
Dentrix experts will teach you tips and tricks to:
• Prevent overdue recall and unscheduled treatment
• Reduce no-shows and keep your chairs full
• Improve and streamline the patient billing process
• Simplify and automate insurance billing
and claim tracking

You will also discover features that help you to:
• Collect and manage accurate patient information
• Improve and simplify schedule management
• Streamline patient payments and track
practice profitability
• Keep your database up to date and properly
backed up

Who should attend:
Doctors, office managers, dental assistants
and other front office team members who need
to learn more about using Dentrix and eServices
to improve productivity.

Insight Seminars offer quick, high-level tip
and tricks
Join us for a morning seminar, enjoy breakfast and gain
valuable insights on improving your productivity. You’ll
also receive a Dentrix Insight Kit with step-by-step
guides for applying what you learned when you return
to the office that afternoon.
Note: CE credits are not offered as part of the Insight Seminar training.
For advanced, hands-on training using a computer we recommend you
attend a workshop. Visit www.Dentrix.com/Workshops
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•
•
•
•

9:00 a.m. to 1:00 p.m.
Continental breakfast
Free parking
To see the full agenda, visit
www.Dentrix.com/InsightSeminar

Space Is Limited. Register Today!
Visit www.Dentrix.com/InsightSeminar
or call 866-367-2711

Tips

&Tricks
The tips in this section describe valuable but easily overlooked Dentrix features that
simplify workflow and increase efficiency. Find the tips that correspond to your role
in the practice and try them out today. Start making your job easier and your practice
more profitable.
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Screen Capture Tool

Showing Transaction Links
Using the Show Transactions Links tool you can quickly
identify every transaction linked to an insurance claim. With
Show Transactions Links activated for a claim, Dentrix highlights the claim, procedures, payments, and adjustments (if
any) associated with it in the Ledger transaction log.
To view the transaction links for an insurance claim:
1. Select a claim from a patient’s Ledger.
2. Click the View menu and select Show
Transaction Links.
Dentrix highlights every transaction entry that is linked to
the one you selected. This can really help you make sense
of a potentially confusing Ledger full of entries.
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Dentrix G5 includes a screen capture feature that allows
you to capture any image on your computer screen,
including graphics, images from third-party software,
X-rays, perio charts, and Web pages. These images can
be stored directly in a patient’s Document Center.
To use the Screen Capture feature:
1. From the Document Center toolbar, select
Acquire > Screen Capture.
2. From the Screen Capture dialog box, select
Start Capture. The mouse icon changes from an
arrow to a cross-hair icon.
3. Click and drag over the area of the screen you
want to import into the Document Center. When
you release the mouse, the image is automatically
stored in the patient’s Document Center.
For more information about using the Screen Capture
feature, log in to the Dentrix Resource Center and view
knowledgebase article #61031. Expand the Dentrix
G5 option, and view the short video titled “Dentrix G5
New Features.”

Viewing Daily Production Amounts
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If you’re setting daily production goals or you just want to see how productive your day
is going to be, try viewing the Scheduled Production Amount in the Appointment
Book. With this feature enabled, you can view your scheduled production amount
just by glancing at the Appointment Book. It’s displayed in the top-right corner of the
Appointment Book next to the Previous, Today, and Next buttons.
To enable this feature:
1. From the Appointment Book menu, click View.
2. Select the view you’re using and click Edit. The Select View dialog box appears.
3. Check the View Amount option and click OK.
4. Repeat for any other views in which you want to see scheduled production amounts.
Note: Dentrix rounds production amounts to the nearest dollar and camouflages
them by adding a zero in front of the amount, making it less likely that patients
will associate the number with revenue.

s
Changing Providers for Selected Procedures
When an appointment is set complete from the Appointment
Book, the procedures are assigned to the appointment
provider. However, in some cases (like hygiene appointments)
the procedures should be posted to multiple providers. You
can quickly change the provider for a completed procedure by
following these steps:
1. Open the Patient Chart and select the patient.
2. In the Progress Notes panel, select the completed
procedure(s) that should be posted to a different
provider.
3. Click the Change Provider for Selected Procedures
button. The Select Provider dialog box appears.
4. Select the correct provider for the procedure(s) and
click OK. The provider is changed for all highlighted
procedures.
By changing the procedures assigned provider from the Chart,
you can change multiple procedures at the same time, saving
you time, and your patient records will more accurately reflect
the patient’s care.
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Note: You will still be able to view the Social Security
number from the Patient Information dialog box in the
Family File and the Update Patient Information dialog
box in the Questionnaires module.

C
ha

1. In the Office Manager, go to Maintenance > Practice
Setup > Preferences and open the General Options tab.
2. Under Additional Options, select Hide Social
Security Number. Then choose an option from the
drop-down list as to how the number will be hidden:
• Hide Completely - Removes the number from
view (the field appears blank)
• Mask Completely - Replaces the digits of the
number with the “#” symbol
• Mask All but Last 4 Numbers - Replaces the
first five digits with the “#” symbol but displays
the last four digits

g

Hiding Social Security Numbers
Did you know you have options about how Social Security
numbers are displayed in Dentrix? With identity theft on the
rise, many people worry about where their Social Security
number might show up. Choosing one of these options can
help your office keep sensitive information safe.
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Tips

&Tricks
How do you spell “anesthesia”?
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Did you know that all editable note fields in Dentrix include a spell check option? Be sure
to use this feature so that your notes are free from misspelled words, making them more
accurate and professional. Simply enter the text of your note in the field provided, and
click the Check Spelling button. The Check Spelling dialog box opens and works just like
any standard spell-check tool. It’s quick and easy to use!

More Information Button
One of the often overlooked but highly useful features
in Dentrix is the More Information window.
The More Information window displays summary
patient information, including patient contact
information, family members, appointment history,
continuing care due dates, and balance information.
You can also access the patient’s Ledger and add an
Office Journal entry from within this window. If you
click on any of the patient’s family members, you can
switch views to see the summary information for the
selected family member.

For more information about how to use this option,
see the “Viewing More Patient Information” topic in
the Dentrix Help.
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You can access the More Information window from
all patient-specific modules, as well as from the Lab
Case Manager, Treatment Manager, and Collections
Manager. Simply click the More Information button to
get started using this great feature.

Digital Impressions
Electronic Services
EXCLUSIVE PARTNER

Cone Beam CT

EXCLUSIVE PARTNER

Digital Panoramic X-rays

CAD CAM Technology

EXCLUSIVE PARTNER

From the Front Office to the Treatment Room and every touch-point
in between, Henry Schein has the solutions you need to connect
your practice technologies. The size of your practice, your budget,
and your patients’ needs are all important to the solutions required
to increase workflow and enhance efficiency.
With your success in mind, let us help you determine which products
and technologies will advance patient care and your practice.

Digital Sensors

Contact your Henry Schein Sales Consultant for details.
EXCLUSIVE PARTNER

Finished Restoration
Intraoral Cameras
EXCLUSIVE PARTNER

EXCLUSIVE PARTNER

1-800-890-8153
www.henryscheindental.com
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Creating an Exceptional
New Patient Experience
Jim Philhower, Director of Dental Leadership & Development
May Wescott, Senior Editor

C

an you remember the last time you had an exceptional customer service
experience? How about a truly awful one? Recently, a friend shared her
best and worst customer service experiences, which both happened at the
same hotel chain. On her first visit to the hotel, she was deeply impressed by the
quality of service she received. She was so pleased with how she was treated that
she specifically chose that hotel for her honeymoon, and she returns each year on
her anniversary. In fact, that first impression was so powerful that even when she
had an awful experience a couple of years ago, the hotel kept her business.
That’s the kind of customer service you want patients who are new to your
practice to experience. You want to provide an encounter that is so positive it will
keep them coming back for years. While it’s not easy to provide that kind of topnotch first impression, with a little bit of planning and some help from your Dentrix
software, you can create an exceptional new patient experience in your office.
The First Visit Appointment Call
The most important thing you need to communicate to a new patient is that
you want to see them. Too often we unintentionally communicate to a potential
client that we’ve got to attend to other, more important patients. We put them
on hold, we tell them we can’t schedule them for weeks, or we hurry them
through that initial phone call without making them feel welcome. Does this
sound familiar? If it does, then you need to make some changes in your new
patient handling, immediately!
Start by making it a priority to schedule new patients. A recent study revealed
that by scheduling a patient within 48 hours of the initial contact, you dramatically increase your show-up rates and your new patient production. Yet, almost
75 percent of dental offices are unable to schedule a new patient appointment
within that 48 hour window.1 Take advantage of what other practices are not
doing for new patients by reserving time in your schedule to see new clients.
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Dentrix makes this easy by allowing
you to set up provider time blocks.
Time blocks allow you to reserve
specific times in the Appointment
Book for certain appointment types,
such as new patient exams. Once
you have set up and activated a
new patient time block, you will see

To create a new patient time block,
open the Appointment Book. From
the Setup menu, click Provider Setup.
Choose your new patient provider and
click Setup. Click Add to create a new
time block. Assign a name, operatory,
and date(s) and time(s) to the block,
and select the type of appointment

Excellent customer service can turn a
new patient into a lifelong patient.
a colored border surrounding the
blocked time, which contains the
time block name and the provider
assigned to that block (Figure 1). If
you attempt to schedule another type
of appointment during the reserved
new patient time, Dentrix warns you
with a message.

that is allowed to be scheduled during
that time. Click OK to save your
settings and return to the Appointment
Book. (If the new patient block doesn’t
show up immediately, try clicking the
Perfect Day Scheduling button on the
Appointment Book toolbar.)

Figure 1 Time blocks allow you to reserve specific times in the Appointment Book
for new patient exams.

1

The Changing Role of the Dental Office Manager. AADOM. 2012 Annual report. http://www.dds1800.com/
whitepapers/The_Changing_Role_of_the_Dental_Office_Manager/. Accessed on 4/5/2013.)
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Make a Personal Connection
During the initial phone call,
make sure to gather some personal
details about the patient. Document
this information in the patient’s
appointment note by double-clicking
on the new patient appointment and
typing the details in the Notes field
(Figure 2). On the morning of the
appointment, these notes will show up
on your Daily Huddle report so that
you can review them in your morning
staff meeting.
When the patient arrives, refer to
the notes so you can personalize your
connection with the new patient. You
can say things like, “So, I noticed that
you were referred by Jane Deacon.
How do you know Jane?” or “I heard
that you moved here from Cincinnati,
what brought you here?” By taking
the time to gather, review, and talk
about these personal details with new
patients, you emphasize that you are
interested in them for more than just
their business.
The VIP Phone Call
Nothing will make a patient feel
more valued than receiving a personal
greeting from their “new” doctor even
before they arrive. Make it a part of
your new patient experience for the
doctor to call potential patients two
days before their first visit. The call
doesn’t have to be long, but it should
give the doctor the opportunity to
thank the patient for choosing your
office and to ask if the patient has any
specific concerns or questions before
the scheduled appointment. This
simple phone call serves to remind the
patient about the appointment while
also making the patient feel like the
Very Important Patient they are.
You can simplify the process of
making these phone calls by creating
a new patient phone call list for your
doctor in the Office Journal. To add
a call to the list, open the Office
Manager, and then click the Office
Journal button. Since you’re opening
the Office Journal from the Office
Manager, you’ll be prompted to choose
a staff member. Select the doctor’s
provider ID and click OK. Then, from
the Office Journal, click Add Journal
Entry. Select Reminder as the Type

Figure 2 Appointment Notes can help to make personal connections with patients
by reminding you of personal details.

annoying business behavior. In fact,
according to service industry research,
76 percent of customers believe
waiting longer than 5 – 10 minutes is
unreasonable. Forty-eight percent of
customers surveyed said that long wait
times indicate that a business is “not
well run or badly managed.”2
Yet, many dental offices think
nothing of asking a patient to sit for
that length of time, filling out paperwork as part of their “new patient
experience.” Many dental offices
rationalize this as necessary. Perhaps
you’ve even gone so far as to warn
the patient, “Come in 20 minutes
before your appointment so that you
can complete some paperwork.” But
to busy new patients who are trying
to cram this visit into a lunch break,
waiting 15 – 20 minutes to be seen
feels like a huge disrespect of their
time. What makes it especially painful
is that in this day and age there’s no
need for it. Technology makes it easy
for potential clients to access new
patient paperwork and consent forms
online, allowing them to complete
these tedious time gobblers when it’s
convenient for them and not when
they’re in a hurry to get back to work.
If you’re worried that new patients
don’t want to go online to access

Make your new patients feel important
by valuing their time, making personal
connections, and respecting their opinions.
and set the Date as the day the doctor
should make the phone call. Type
the new patient’s name and phone
number in the Note field and click
OK. The doctor can either launch the
Office Journal to access the reminder
list before making the VIP phone calls,
or you can print a filtered list for the
doctor to take home (Figure 3).
Figure 3 The Office Journal allows you
to generate interactive New Patient Call
lists for your doctors.

2
3

Timing is Everything
Most people rank being asked to
wait as first or second on their list of

forms, don’t be. In the same service
industry study, researchers found that
87 percent of respondents would use
technology if it would save them 15
minutes of wait time.3
A Dentrix eCentral website can
make this process even more streamlined by not only allowing patients
access to your new patient forms,
but also by allowing them to complete
your forms through a secure Internet
connection. With an eCentral website,
you can create custom forms in the

“New Survey Reveals How Much Customers Hate to Wait.” http://www.greatclips.com/about-us/press-room/time-survey. Accessed online 4/12/2013.)
Ibid

DENTRIX MAGAZINE | 13

Dentrix Questionnaires module that can
be uploaded to a special New Patients
page on your website. New clients
access the forms by typing in their
name and appointment date (Figure 4).
Once the forms have been submitted,
they show up on your computer in the
Questionnaires module. You can then
import the information directly into your
Dentrix database, saving your staff from
having to manually enter the information
(which further extends your new patient’s
wait time).
Follow Up
The exceptional new patient experience doesn’t end when the new patient
leaves your office. Be sure to follow up
the patient’s visit with a phone call asking
for feedback. Communicate to the new
patient that you wanted to exceed their
expectations and ask if you were able
to do so. Ask specifically what you did
well and what you can do better. End the
phone call by thanking them for choosing
you as their dental care provider.
To make certain that you’re consistently
gathering the same information, add a
New Patient Exit Interview questionnaire
to the Dentrix Questionnaires module.
You can use the questionnaire as a script
for the phone call and as a place to store
the information (Figure 5). Every week,
you can open the Questionnaires module
and review the responses to the interviews you’ve stored as a way to help you
identify where your new patient experience is succeeding and where you’ve got
some room for growth.
Excellent customer service can
turn a new patient into a lifelong patient.
Make your new patients feel important
by valuing their time, making personal
connections, and respecting their opinions.
By taking these steps, you create a truly
exceptional new patient experience.
LEARN MORE
To learn more about setting up provider
time blocks, visit the Dentrix Resource
Center to view the “Perfect Day Scheduling”
on-demand training title. You can learn
more about using the Office Journal by
viewing the “Office Journal” section of the
Dentrix Help. To learn more about using
Questionnaires, see the “Questionnaires”
section of the Dentrix Help. See “How to
Learn More” on page 2 for instructions on
accessing these resources.
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Figure 4 New patients can easily access and complete online
versions of your forms by signing on to your eCentral website.

Figure 5 The Questionnaires module makes it easy to
follow up a new patient visit with a satisfaction survey.

Erin Brisk
Contributing Editor

Act Now to Boost
YEAR-END PROFITS
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N

ow that the back-to-school rush is over, it’s time to start thinking about the end of
the year. It’s a great time to encourage patients with dental insurance to use their
insurance benefits before they expire. Many patients don’t realize that they have

unused insurance benefits, or they’re unaware that unused benefits expire. By contacting
your patients now, you’ll be doing them a favor by helping them maximize their remaining
insurance benefits, and you’ll be giving your practice a year-end profitability boost.
Dentrix has several tools and features that can make it easy to for you find and contact
these patients. You can use the Treatment Manager to get a list of patients who have
treatment-planned procedures and remaining insurance benefits, and then you can use
the tools in the Treatment Manager to contact individual patients by phone, email, or
letter. If you want to send a letter to the entire group of patients who have treatmentplanned procedures and remaining insurance benefits, you can use the Letter Merge to
merge year-end letters for the entire group at once.

Creating a Filtered List of Patients
One of the most powerful tools available is the Treatment Manger (Figure 1). You can
use the Treatment Manager to generate a filtered list that shows just the patients you
need to see. And since the Treatment Manager is an interactive list, once you’ve generated the custom list of patients you can work directly from the list to call patients, send
email messages, generate quick letters and quick labels, make Office Journal notes, and
enter guarantor notes.

Figure 1 The Treatment Manager is an interactive list you can use to find specific patients and
then contact them.

To access the Treatment Manager, from the Appointment Book click the Treatment
Manager button. In the Treatment Manager View dialog box, specify your filter criteria.
The Treatment Manager list will be generated based on the criteria you specify.
You can enter any filter criteria that makes sense for your practice, but if you’re
contacting patients about scheduling an appointment before the end of the year, it’s
a good idea to find patients who meet the following criteria: a) active patients, b) have

Figure 2 Use the options in the Treatment Manager View settings to filter the patients that
appear on the list.

insurance, c) have at least $100 of either
primary or secondary insurance benefits
remaining for the year, d) have a treatment plan worth at least $10 that was
diagnosed in the last year, and e) are not
on either the Bad Debt, Payment Plan,
or No Insurance billing types (Figure 2).
Once you have set up the search criteria,
click OK to generate the list.

Contacting Patients Using
the Treatment Manager
Once you have generated the
Treatment Manager list, you can look
at the information about each patient
and decide if you want to contact them,
and if so, how you want to do it. For
example, if you know a patient has a
flexible schedule and can schedule

Figure 3 The More Information dialog box shows you all of
the patient’s contact information, along with appointments,
continuing care, and balance information.

18 | www.Dentrix.com/Magazine

an appointment right away, select the
patient and click the More Information
button to see a list of that patient’s
contact information (Figure 3). Call the
patient and schedule the appointment.
Then, right-click the patient and select
Hide Patient to hide them from the list
once you have contacted them.
You can also use the Treatment
Manager to contact patients who
respond best through email. Select a
patient and click the Send Message
button. A blank email message will
open. If the patient has an email address
entered in the Family File, the patient’s
email address will be listed in the To:
field. You can then type the message
and send it to the patient (Figure 4).
If you want to send a letter to certain
patients, you can generate a quick
letter from the Treatment Manager that
shows patients their treatment plan
totals and remaining insurance benefits.
Select the patient to whom you want to
send the letter, and then click the Quick
Letters button. In the Quick Letters
dialog box, select the letter called
Treatment Plan Reminder (dtxlm21.doc)
and click Print (Figure 5). (Note: The
Treatment Plan Reminder letter may
not be available in your Quick Letters
dialog box. If it isn’t, follow the instructions in the “Adding Letters to Quick
Letters” topic in the Dentrix Help to
add it.)

Figure 4 If you have a MAPI-compliant email server (such as Microsoft
Outlook) set up in your office, you can quickly generate a customized
email message.

With a patient
selected in the
Treatment Manager,
click the Treatment
Planner button to
open the Treatment
Planner directly. From
there you can view
the patient’s treatment plan to decide
which procedures are
the priority for the
amount of insurance
benefits remaining.
You can also
access the other
Figure 5 You can use Quick Letters as needed to create a single
Dentrix modules
letter for just the selected patient.
from the Treatment
Manager. Click the
Ledger button to
You can also print a mailing label to
view patients’ balance information
attach to the letter by clicking the Quick
and outstanding insurance claims to
Labels button. From the Quick Labels
ensure that their accounts are in good
dialog box, select Patient Mailing Label,
standing before you contact them. Click
and then click Print (Figure 6).
the Family File button to view patient
information, patient notes, and specific
Finding More Information Using the
insurance plan information.
As you are contacting patients, it’s
Treatment Manager
Not only does the Treatment
a good idea to create an Office Journal
Manager give you several options for
entry that summarizes the contact. That
contacting patients, but because it’s an
way if there are several different people
interactive list, you can use it to find any
in your practice contacting patients,
information you need about a specific
you can see who was contacted, when
patient or their account. You can also use
they were contacted, and how. To add
it to enter guarantor notes with informaan Office Journal entry, select a patient
tion you get from patients as you talk to
on the list and click the Office Journal
them, and you can create Office Journal
button. From the Office Journal, click the
entries to keep track of your contacts
Add Journal Entry button to document
with the patient.
the patient contact you made (Figure 7).

Figure 6 You can easily mail a letter, statement, or postcard to an individual patient by using
Quick Labels to create a single mailing label.

Sending Year-End Letters Using the
Letter Merge
Some practices may want to
generate letters for the entire group of
patients who have treatment-planned
procedures and remaining insurance
benefits all at once. Then, after the
patients have received the letter and
had a chance to respond, you can use
the Treatment Manager to follow up with
each patient individually.

Figure 7 It’s important to document the phone
calls, emails, and other patient contacts you
make so you can remember what was said and
prevent duplicate contacts.

The Dentrix Letter Merge allows
you to send a letter to all the patients in
this situation. You can set up data filters
in the Letter Merge that are similar to
the ones in the Treatment Manager to
narrow the list of who will receive the
letter. This way, only active patients
who have treatment-planned procedures and at least $100 of remaining
insurance benefits will receive the
letter. Additionally, you can also set up
filters to exclude patients who have an
outstanding balance or are attached to a
particular billing type.
To merge the letters, from the
Office Manager, click Letters > Misc.
In the Misc. Letters dialog box, select
the Treatment Plan Reminder Letter
(dtxlm21.doc), and click Edit to set up
the filters you want to use for this letter
(Figure 8). (For detailed instructions
about setting up the appropriate filters
for the year-end letter, log in to the
Dentrix Resource Center and search for
article #67325.)
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Figure 8 You can use the Treatment Plan Reminder letter to remind
patients of their outstanding treatment and inform them of the amount
of insurance benefits they have remaining.

Once you have set up the filters, click
Create/Merge to merge the letters.
Dentrix will create a data file that contains
all the patients who match your filter
criteria and then merge the information
into Microsoft Word (Figure 9). You can
then print the letters from Microsoft
Word. Once you’ve merged your letters,
you can generate mailing labels for all
patients receiving a letter using the
dtxlabl.doc letter template.

Figure 9 Dentrix will create merged letters in Microsoft Word for patients
who have remaining insurance benefits that you can send to patients
before the end of the year.

Don’t wait until November to contact
your patients about maximizing their
insurance benefits and scheduling treatment before the end of the year. Begin
contacting patients now so that you can
plan for a productive final quarter of the
year that will meet the needs of your
patients and give you a boost in
year-end profitability.

LEARN MORE
To learn more about the Treatment
Manager, see the “Treatment Manager
overview” topic in the Dentix Help. To learn
more about creating year-end letters, see
the “Remaining Insurance Benefits Letter”
article (article #55937) in the Dentrix Resource
Center. See “How to Learn More” on page 2
for instructions on accessing these resources.

DENTRIX BUTTONS
This article mentions several Dentrix buttons you can use to access different features and information in the software.
Below is a guide to the buttons mentioned in this article.

Opens the Treatment Manager, which allows you to
create a filtered list of patients with outstanding treatment plans. Available from the Appointment Book.

Opens the Treatment Planner. When you click this button
in the Treatment Manager, you do not have to go through
the Patient Chart to access the Treatment Planner.

Opens the More Information window, from which you
can see patient contact information, appointments,
continuing care, and balance information.

Opens the selected patient’s Ledger, which allows
you to view their current balance information and
outstanding insurance claims.

Opens a new email message with the patient’s email
address in the To: field.

Opens the selected patient’s Family File, which allows
you to view patient information, patient notes, and
insurance plan information.

Opens the Quick Letters dialog box, which allows you
to merge a letter with the currently selected patient’s
information.
Opens the Quick Labels dialog box, which allows you
to generate a single mailing label for the currently
selected patient.
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Opens the Office Journal for the selected patient,
where you can keep a log of all the contacts you’ve
made with the patient.
Opens the Add Journal Entry dialog box, which allows
you to add a new entry to the selected patient’s Office
Journal to document contact you had with that patient.
Available in the Office Journal.

Get Expert Advice with
a Personal Touch

Let our experts show you how to put all the features of Dentrix to work for
your practice, and help you identify the reports and performance metrics you
should focus on to gain greater profitability.

With Dentrix Profitability Coaching you’ll learn ways to:
• Improve coding accuracies

• Give more accurate patient estimates

• Keep patients coming back

• Get timely insurance payments

• Collect what you produce

• Keep your schedules filled

• Increase treatment acceptance rates

• Go paperless

Visit www.Dentrix.com/ProfitabilityCoaching
Or Call 866.609.5510
©2013 Henry Schein, Inc. A-DTXPC-Q113

The Dentrix Office Manager
Use Dentrix to Resubmit a Partial EOB
Learn how to split an insurance claim in the Ledger so you can process a partial payment.

Dayna Johnson | Certified Dentrix Trainer

I

t’s Monday morning, and you’re
going through the weekend mail to
start catching up on your insurance
payments. As you start posting your
first EOB in the Dentrix Ledger, you
notice that the insurance carrier paid
for the exam and bitewings, but they
need an updated perio chart before
they will submit payment for the perio
maintenance cleaning. Which one of the
following do you do?
A. Apply the partial payment, close out
the claim, and then print an extra
copy so that you have something to
refer to because the original claim
will not show up on your Insurance
Aging Report.

B. Resubmit the entire claim with the
perio chart and hold the partial
payment until you receive payment
on the perio maintenance, and then
post both checks together.
C. Put it off until later and call Dentrix
Customer Support.
D. Split the claim into two parts, apply
the partial payment to the exam
and bitewings, and leave the perio
maintenance open so it will show up
on your Insurance Aging Report.
The correct answer is . . . D. Dentrix
makes it easy for you to split an insurance claim in the Ledger so you can
process partial payments. If you don’t
know how to split an insurance claim, I’ll
show you.

Splitting an Insurance Claim
From the Ledger, highlight the
claim that you want to split. From the
Insurance menu, click Split Primary
Claim. In the Split Claim for... dialog
box, highlight the perio maintenance
procedure and click the down arrow
to move it under Claim #2, as shown in
Figure 1. Click OK .
You now have two separate insurance
claims. You can pay off the claim for the
exam and bitewings with the check you
received today, and you also have an
open claim that you can attach the perio
chart to and resend to the insurance
company for payment. The perio claim
will still show up on your Insurance
Aging Report for easy tracking.
You can use this procedure for
other situations such as rebilling when
a crown buildup has been denied,
when X-rays have been requested, or
when other denials or partial payments
require submission of a narrative to the
insurance company.
LEARN MORE
To learn more about splitting insurance
claims, see the “Splitting primary insurance
claims” topic in the Dentrix Help. You can
also view the Claims Management webinar
recording in the Dentrix Resource Center.
See “How to Learn More” on page 2 for
instructions on accessing these resources.

Figure 1 The Split Claim for dialog box.
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Dayna Johnson, founder and principal
consultant of Rae Dental Management, helps
dental offices improve patient care, increase
collections and reduce staff headaches by
implementing efficient management systems.
With 19 years experience in the business
and technical side of dental offices, Dayna’s
passion for efficient systems is grounded
in both personal understanding and
professional expertise. Dayna can be reached
at dayna@raedentalmanagement.com or visit
her website at www.raedentalmanagement.com.

From the Coach
Save Time with Online Forms
Save time and increase customer satisfaction by allowing patients to update their medical
history and patient information forms online.

Christy Rasmussen | eServices Coach

I

Resource Center to view the
“Posting Questionnaires
on Your Website” article
#61032.)
Once the forms are set
up, both new and existing
patients can complete forms
online. When a new patient
visits your website, they can
access forms by entering
their name and appointment date. When existing
patients visit your website,
they will need to log in using
the credentials they created
when they registered for the
site (Figure 1). Once logged
Figure 2 Any forms that patients need to fill out or
in, they can then click the
Forms tab to see what forms update are listed on the Forms tab.
they need to fill out for their
next visit.
To begin working on a
form, the patient simply
clicks the name of the form
(Figure 2) to open an online
version of it. For existing
Figure 3 A pop-up notification appears
patients, any previously
to let you know that a new form is ready
entered information is
for import.
displayed in the form so
that the patient can simply
correct changed information, rather than having
the forms to update the patient’s Family
to enter all the information
File with just a few clicks.
again. The patient
Patients will thank you for the convecompletes the form a
nience of online forms, and you’ll love it
nd then clicks submit
for the efficiency it adds to your frontwhen finished.
desk routines.
Meanwhile back in the
office, staff will receive a
LEARN MORE
pop-up notification in the
To learn more about online forms, see
the “Website Manager” topic in the eCentral
lower-right corner of the
Help, visit www.dentrix.com/websitemanager,
desktop, indicating that a
or visit the Dentrix Resource Center to view
new form is available for
the “Allowing Patients to View and Update
import (Figure 3). By clicking
Their Info Online” article #61033. See “How
the notification (or by going
Figure 1 Existing patients can log in to a secure loto Learn More” on page 2 for instructions on
in to the Questionnaires
cation on your website to view and update their forms.
accessing these resources.
module), your staff can use
n a recent survey, 87 percent of
customers said they would rather fill
out forms online before their appointment if it would save them time during
their visit. Why not give your customers
what they want by allowing patients to
update their medical history and patient
information forms online before their
dental appointment? With Dentrix and
the eCentral Website Manager, patients
can complete their forms online on your
practice website. Best of all, once they’ve
completed the forms, you can import
them directly into Dentrix without having
to type a thing.
To get started using online forms,
you need to set up the forms in the
Questionnaires module and then link
them to your website through the Web
Sync wizard. (For more information on
setting up online forms, visit the Dentrix
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Business of Dentistry
Proven Strategies to Increase
Your Collections
Help yourself move into a higher collections percentage on past
due balances by using these tips to work with overdue accounts.

Jill Nesbitt, MBA | Practice Administrator and Dental Consultant

H

elp me to help you!” I love
that line in Jerry Maguire. It
sums up the old truism that
help comes after we help ourselves.
This can be especially true when it
comes to collecting from patients
with past due accounts. By spending
a little time gathering accurate
information and “working” our
past due accounts before we send
them to collections, we have seen
dramatic increases in our ability to
collect unpaid balances.

Helping Ourselves to Collect
To make sure no one has slipped
through the cracks as we follow
our regular “collect at the front
desk” guidelines, our collections
routine starts with using the Dentrix
Collections Manager (Figure 1).
To start the Collections Manager,
open the Office Manager and click
Analysis > Collections Manager.
Figure 1 The Dentrix Collection Manager can help you to work your collections routine
You’ll be prompted to select search
more efficiently.
criteria so that you can limit your list
to only past due accounts. (For more
help in choosing your search criteria,
have several different letters we
		 I really like how Dentrix autosee the “Setting up a view for Collections
use as the situation requires. For
matically adds a note to the Office
example, we have letters for when
Journal indicating the date the
Manager” topic in the Dentrix Help.)
patients have stopped making
letter was created and the letter
Once we have the report open, we
follow a quick process for accounts that
payments or when they’ve only
name. That way, if patients want
to talk about the letters they’ve
need to be paid:
made a partial payment.
received (or they claim they’ve never
1. Send a statement. If we can see
		 Quick Letters makes it easy
to quickly generate the most
received), I have a readily available
that the account is recently past
history of our correspondence.
due, we select the guarantor in
appropriate letter right from
the Collections Manager and then
the Collections Manager. After
3. Send a second, more forceful
click the Ledger button. From the
selecting the guarantor in the
letter and make a second phone
guarantor’s Ledger we can then
Collections Manager, click the
call. In addition to being able to
click the Process Billing Statement
Quick Letters button. Next, select
use our customized Quick Letters,
button to send a statement to the
the letter you want to merge and
the Collections Manager also helps
patient right away.
click Build/View (Figure 2). The
by making phone calls a snap.
2. Send a courtesy letter and make
letter opens in Microsoft Word with
By selecting the patient I want to
the patient’s name, address, and
contact and then clicking the More
a phone call. We created our own
collection letters and mail merge
other pertinent information merged.
Information button, I can see a list
them using the Quick Letters
Simply review the letter, make any
of all the available phone numbers
feature in Dentrix. In addition to
changes, and click File > Print to
for the patient (Figure 3). Plus, I
our standard courtesy letter, we
print the letter.
can click the Add Journal entry
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was given good information to work with!)
After discussing
our Integrity Analysis
Report with the agency,
I shared the results with
our administrative team.
We were all surprised at
how drastic the difference was, merely by
providing good
contact information.
Thanks to this review
our team now makes
sure that we’re sending
every possible phone
Figure 2 You can use the Quick Letters feature to
number and address
generate customized collection letters.
we have available to the
agency. Additionally,
our staff tries to gather
button to record details about the
this information early on as part of our
conversation with the patient.
collections process. We’ve realized
4. Decide to either write off the
that if we can make sure we have good
balance (if it’s less than $100) or
phone numbers and addresses as part
send it to collections. For patients
of the payment collection process,
that continue to ignore us (and
perhaps we can continue to collect past
that have an account balance over
$100), we send the account to a
collections agency. I’ve worked with
several different agencies over the
years, and we’ve settled on one that
makes phone calls rather than just
sends letters since we’re handling
that on our own.

Helping Your Collections Agency to
Help You
Despite our best efforts, we still wind
up with past due accounts that we must
send out to a collections agency. But,
after a recent performance review with
our collections agents, I discovered how
much we could help them to help us.
At my request, the agency
completed an Integrity Analysis Report
that revealed some very interesting
trends. The agency was only able to
collect 12 percent on accounts where
we provided them with a correct
address but the phone number(s) were
disconnected or wrong. However, if we
provided them with a working phone
number and a correct address, their
collections jumped to 40 percent. Even
more amazing, if we could also provide
them with valid work and home phone
numbers, the agency was able to collect
about 75 percent of the balances owed.
(To put that in actual dollar amounts, if
we had $1,000 in collection accounts, we
could collect an additional $630 just by
making sure that the collection agency

due balances even when the patient
becomes non-responsive to our efforts.
Managing your past due balances
is never fun, but by putting processes
in place to standardize your collections
operations, you’ll help yourself move to a
higher collections percentage.
Jill Nesbitt is a dental consultant
piloting a comprehensive dental staff
training program in Nashville after
managing a group practice with six dentists,
twenty staff, and eighteen operatories for
16 years. Jill has an MBA and writes a weekly
blog, www.dentalpracticecoaching.com.
Jill is passionate about helping other office
managers develop their careers and helping
their dentists run successful businesses
through her consulting practice.

LEARN MORE
To learn more about using the
Collections Manager, see the “Collections
Manager” topics in the Dentrix Help. See
“How to Learn More” on page 2 for more
information about accessing this resource.

Figure 3 The More Information dialog box allows you to see phone numbers and
add contact notes to the Office Journal.
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TechNotes
Wi-Fi for Your Waiting Room
Learn how adding a Wi-Fi network to your waiting room can benefit your practice.

Jason Werner | Marketing Manager, Henry Schein TechCentral

W

ithin the next three years, it is
predicted that the number of
mobile devices in use will likely
exceed the number of people on Earth.
According to a CTIA study last year, the
number of mobile devices in use in the

A few years ago, practice
visitors expressed surprise
at the availability of
Wi-Fi—now they are
frustrated by its absence.

United States has already exceeded the
U.S. population. Statistically, this means
that every person in your waiting room
carries at least one device capable of
connecting to the Internet. Do you have a
Wi-Fi network available for your patients
and visitors to use? And if so, does your
Wi-Fi network also keep your business
network private?

Why Should I Care?
This is the information age and your
patients have embraced technology. They
receive news updates, tweets, RSS feeds,
and texts throughout the day. For many
patients, the stacks of magazines cluttering
your waiting room may not have as much
significance as they did in past years—but
a Wi-Fi connection does. Free Wi-Fi is a
standard amenity in most businesses. A
few years ago, practice visitors expressed
surprise at the availability of Wi-Fi—now
they are frustrated by its absence.
What’s in It for Me?
These are just a few of the benefits of
adding free Wi-Fi to your practice:
Save time. A Wi-Fi network, kiosk
software for Dentrix, and a few iPads
allow patients to check in and update
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information without involving office staff.
This frees up time for your team to help
other patients or work on tasks other than
data entry, and they won’t waste time
deciphering patients’ handwriting.
Reduce clutter. Free Wi-Fi for your
visitors allows you to cut down on
magazine subscriptions for your waiting
room. Many patients will occupy themselves with online banking, webinars,
and business from their smartphones,
tablets, or laptops.
Improve patient relations. Although
your patients have appointments, schedules do not always run on time. Free Wi-Fi
access shows your patients that you value
their time by helping them stay productive while they wait.
Create goodwill to win new
patients. Not all of your Wi-Fi users are
patients—at least not right now. A friend
or relative waiting with your patient is a
prospective patient. Free Wi-Fi in your
waiting room is an amenity that can tip
that prospective patient in your favor.
Gain a competitive advantage.
Consumers love free. Offering free
Wi-Fi is a powerful marketing tool and a
competitive advantage for your practice.
Poise your practice for future
growth. The demand for Internet
access will continue to grow—both for
your patients and your practice. Going
forward, you’ll see new dental and business devices cut the cord and rely solely
on Wi-Fi connectivity. Dentrix Mobile is a
perfect example of how critical practice
solutions are moving to mobile devices.
Look at how often smart phones and
tablets are used in your practice now.
Connecting these devices via Wi-Fi, as
opposed to using a carrier’s data plan, is
less expensive, faster, and more secure.

With Great Wi-Fi Comes Great
Responsibility
Wi-Fi is a powerful tool, and with it
comes a responsibility to your patients.

You must properly set up and configure
your wireless router to keep your practice data safe and to keep undesirable
websites, inappropriate content, and
malicious malware out of your practice.
Henry Schein’s TechCentral experts
can provide your office with a businessgrade Wi-Fi router and installation to
get you safely and quickly connected.
TechCentral’s Wi-Fi solution uses one
Wi-Fi router to provide separate and
secure wireless networks for both your
visitors and your business staff. The
business Wi-Fi is hidden from the public
and ensures that visitors can’t get to your
protected data and files.
TechCentral will also provide Internet
security measures that continually selfupdate for protection against the latest
Internet threats including the following:
• Websites that contain malicious
software that infect PCs.
• Continual hacks that attempt to
probe your network and commandeer your PCs.
• Websites that contain X-rated
materials, gambling, and other
undesirable content.

Get Secure Wi-Fi for Your Practice
Henry Schein’s team of TechCentral
experts can quickly determine your Wi-Fi
needs and provide an affordable
solution. More than 7,000 practices
already rely on TechCentral for computer
technology and support. A Henry Schein
digital technology expert can visit your
office, review your current technology,
and make hardware recommendations.
Whether you are adding Wi-Fi or
upgrading your current network, a Henry
Schein expert can provide high-performance Wi-Fi while keeping your practice
safe. Call 877-483-0382 to schedule your
free practice technology assessment, or
visit www.HenryScheinTechCentral.com
for more information.
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SOLUTION SPOTLIGHT

OfficeSuite Dental and Dentrix:

Increase Revenue by Maximizing Patient Interaction
Kevin Goodman | Managing Director of Channel Strategy & Development for Broadview Networks
Learn how OfficeSuite Dental integrates with Dentrix to improve front-office efficiency and patient customer
service by automatically displaying detailed patient information each time patients call your office.

T

here are many dental practices vying for new business,
and one of the easiest ways to set yours apart is to
provide unparalleled customer service. At Broadview
Networks, we understand your unique challenges, including
increasing revenue, improving patient satisfaction, and
boosting staff productivity—all while keeping operational
expenses to a minimum.
OfficeSuite Dental™ helps dental practices achieve all
these objectives by delivering an all-inclusive communications
solution that is easy to use. It provides your practice with
everything it needs to communicate with patients and other
practice locations: a cloud-based phone system, unlimited
nationwide calling, state-of-the-art IP phones, basic and

advanced system features, online fax service and call center
services—all without any capital investment, maintenance
contracts, or additional IT resources. Since the system is
cloud-based, you can quickly and easily make changes and
updates from anywhere, helping you to reduce operational
expenses and ensure practice and patient continuity.
OfficeSuite Dental gets even more powerful when it is
integrated with your Dentrix G5 practice management software.
OfficeSuite Dental is the first phone system to integrate with
Dentrix. It helps your practice increase revenue by maximizing
every patient interaction.
Here’s how it works. When a patient calls your practice,
before the call is even answered, OfficeSuite Dental triggers an
automatic pop-up window on front-desk staff
PCs that displays patient records, including
family history, appointments, clinical details,
prescriptions, and account balances (Figure
1). By having all this data at their fingertips,
your staff can create, confirm, or reschedule
appointments in seconds for the patient and
family members, and even answer questions
about prescriptions and treatments. They
can also collect overdue balances.
OfficeSuite Dental enables your
employees to not only anticipate patients’
needs, but to also address multiple needs
with one short phone call without any
searching. And, by enabling staff to accomplish multiple tasks in less time, you can
boost your practice’s overall efficiency while
lowering your day-to-day costs.
OfficeSuite Dental is powered by the
information already stored in your Dentrix G5
database and provides your staff with instant
access to patient data and call records with
every incoming call so they can deliver fast,
Figure 1 A pop-up window displays patient information the moment they call.
helpful, and personalized service (Figure 2).
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Delivering fast and personalized service makes all the difference
in retaining existing patients, attracting new ones, and
increasing your practice’s revenue. Instead of having to put
callers on hold and waste time looking up information in a
separate system, OfficeSuite Dental puts everything in one
place. If you can meet your patients’ needs in a way that fits their
hectic lifestyles, they will thank you by giving you more of their
business and referring friends, family, and colleagues. This is
just one of the many ways OfficeSuite Dental helps you grow
your practice and your bottom line organically.
Imagine if staff could book multiple appointments in one
phone call:
“Hi, Mrs. Smith. Are you calling to confirm your appointment
at 1:30 tomorrow? Great, we’ll see you then. And by the way, it
looks like your son’s six-month cleaning is due. How is next
Wednesday at 4:00? Perfect, you’re all set.”
OfficeSuite Dental makes it easier for your staff to see
scheduling opportunities and book more continuing care
appointments each time patients call your office (Figure 3). It also
reduces the number of calls they must make to patients, helping
you increase revenue and decrease operational expenses.
In a similar fashion, your staff no longer has to mail as many
bills or make as many phone calls reminding patients of
outstanding balances. With OfficeSuite Dental, all of that
account information is in front of your office staff when the
patient calls. Staff can remind patients on the spot and settle
accounts instantly.
OfficeSuite Dental saves time and improves efficiency by
providing your staff with one-click access to all the Dentrix
functions. With a single click in the OfficeSuite Dental pop-up
window, you are taken to the appropriate place in Dentrix for
the patient who is calling. Staff can access and update the
patient’s appointments, family file, contact information, chart,
prescriptions, and ledger. And since OfficeSuite Dental displays

Figure 2 See who is calling and anticipate their needs before
picking up the phone.
the patient’s information the instant your phone rings, your staff
never has to type their name, saving time and reducing dataentry and operational costs.
OfficeSuite Dental delivers other benefits for practices. It
helps you prioritize calls to ensure that patients speak to the
right person every time. For example, the skills-based routing
feature forwards calls to the employee best equipped to
assist patients based on their needs, such as a procedural
specialist or billing manager. In addition, OfficeSuite Dental
helps you generate additional revenue from existing patients
by using announcements on hold to inform callers of any
current promotions.
Besides helping you improve the level of service that you
provide to existing patients, OfficeSuite Dental also helps you
improve new patient acquisition. Enjoy higher ROI on marketing
efforts by tracking the success of campaigns and making
adjustments to your advertising strategy based on real data. It
takes the guesswork out of marketing by
showing you what works so you can maximize
the advertising dollars you spend.
OfficeSuite Dental also saves your practice
real money since it is easy to manage, saving
you from having to pay extra for simple
changes to the system. Adding a new staff
member takes only minutes. Changing the
call routing on days when your office must
close (for holidays, inclement weather, and so
forth) is easily accomplished via an intuitive
website that is accessible from your smartphone or tablet.
Increasing revenue is the ultimate goal of
every dentist. The challenge is to find one
solution that helps you accomplish all the
objectives that directly affect revenue,
including patient satisfaction. With
OfficeSuite Dental, your staff has all the tools
they need to maximize every patient interaction and help grow your practice.

Figure 3 Increase revenue by booking more appointments for patients and
their family.
The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their
company, products and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions
and consumers should contact these providers directly if seeking additional information about their products or services.

DENTRIX MAGAZINE | 29

Solution Guide
You already depend on Dentrix to make your practice more profitable and productive. Now
with Dentrix G5 you can add fully integrated third-party applications to make one powerful
system that saves you time and increases the value of your technology investment.

Look for the Dentrix G5 Connected Logo
The Dentrix G5 Connected logo means these products have been carefully developed,
tested and certified to work with your Dentrix G5 platform, so you can add new capabilities
with complete confidence. To see the full list of Dentrix G5 Connected applications visit
www.Dentrix.com/Integrated-products today.

Broadview

Citi

www.broadviewnet.com

www.healthcard.citicards.com

Network-Based Business Communication

Citi Health Card

Make your practice more profitable with OfficeSuite
Dental the state-of-the-art phone system that
fully integrates with Dentrix G5. Increase patient
satisfaction and enhance employee productivity
with OfficeSuite Dental, the easy-to-use cloudbased phone system designed to make Dentrix G5
even more powerful.

One click. One solution. Patient financing just got
a lot easier. The Citi® Health Card program is now
integrated within Dentrix G5. Spend more time
on patient care and less money on your patient
financing program costs. Citi Health Card and
Dentrix … ”Some things are just better together.”
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DentalWriter

Practice Safeguard

www.dentalwriter.com

www.practicesafeguard.com

DentalWriter for Dentrix G5

Web-Based Fraud Monitoring

For over 25 years, Nierman Practice Management,
known for their Dental Writer™ and Cross Code™
software, has led medical billing in dentistry by
continuously developing innovative products
and providing exceptional training and seminars
for dentists looking to grow their practices with
Dental Sleep Medicine, TMD, oral surgeries and
other services.

Practice Safeguard™ is an intelligence service
for dentists unlike anything before: A web-based
financial monitoring tool for Dentrix G5 users that
deters fraud and costly errors by alerting any device
you carry to unusual transactions in real time. Now,
you can resolve potential issues instantly. See what
financial security should be. Early adopter pricing
is available now.

Demandforce

Text2Floss

www.dentrix.com/demandforce

www.Text2Floss.com

Demandforce for Dentrix

Patient Education

Demandforce works seamlessly with Dentrix G5
software to automate online and offline communi
cations with existing patients to improve in-office
efficiencies, help enhance your web presence with
online reviews and social media integration to
attract new patients and increase brand awareness,
all while measuring results month to month.

Text2Floss is an interactive educational tool meant
to help patients develop positive oral hygiene
habit by delivering oral health information through
the use of text messaging and mobile technology.
Text2Floss is an initiative of A.T. Still University’s
Arizona School of Dentistry and Oral Health.
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Henry Schein Practice Solutions
727 E. Utah Valley Dr.
American Fork, Utah 84003

Discover Everything You Can Do

With Dentrix

The New, Smart Way to Learn
Dentrix Learning Plans—as well as unlimited access to our resource center—are yours at no additional cost with your Dentrix
Customer Service plan. That means you gain instant access to video tutorials, webinar recordings, user’s guides, getting started
guides, knowledgebase articles and much more—all organized by common tasks or job function for easy, convenient reference.

Dentrix Learning Plans Help You:
•
•
•
•
•
•

Get the most out of your Dentrix investment
Keep team members informed and productive to boost profitability
Drive team motivation and loyalty by providing learning and growth
Get new employees up to speed quickly and easily
Cross-train team members to do more in your practice
Promote continuing education and skill building

Give your practice and staff a competitive edge today.
Find out more about Dentrix Learning Plans at:

www.Dentrix.com/ResourceCenter
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